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SENDING EMAIL 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Email messages are used in much the same way as letters 
sent through the post – they are designed to communicate 
with one or more people. 

Like any good letter, an email message needs to be 
addressed (although a special electronic form of addressing 
is used here). Email messages also appear with a subject 

so that they can be identified.  

Messages can also be marked as important, and have 
sensitivity levels and settings (such as confidential, private 
and so on) applied. 

In this booklet you will: 

 gain an understanding of email accounts in 
Outlook 

 gain an understanding of how the Outlook mail 

process works 

 gain an overview of composing an email message 

 gain an overview of the ribbon and header areas 
in the message window 

 learn how to create a new email message 

 learn how to check the spelling of your email 

messages 

 learn how to add an attachment to an email 
message 

 learn how to add importance to email messages 

 learn how to request message receipts 

 learn how to send a message in Outlook 

 learn how to create an autosignature for your 
email messages 

 learn how to use an AutoSignature 

 learn how to remove an unwanted 
AutoSignature 

 learn how to send a courtesy copy to a recipient 

 learn how to send a blind copy of an email 

INFOCUS 
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EMAIL IN OUTLOOK 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Outlook mail operations allow you to 
communicate with users connected to your 
computer network (this is usually people 
within your business in the same building) 

or with users external to your business or 

building connected via the Internet. 

Email Accounts 

When you communicate with other people using email your messages and theirs are 
controlled on a central computer known as a mail server. To have access to that 
server you must have a mail account with that server. A mail account here is not a 
financial type of account, but rather an account that provides you with permission to 

access the server. Once the account is set up, you normally gain access to the mail 
server with a user name and a password. 

Email Accounts and Outlook 

Outlook supports both internal and external email accounts.  

Internal email accounts are normally associated with a computer on your network 
that is running Microsoft Exchange Server – special software created by Microsoft 
that allows users to send messages to one another over a network of connected 
computers. Internal email allows you to communicate with people within your 
organisation. Internal email requires that the internal computers are connected using a 
local area network (LAN). This type of email account is normally used in the 
workplace to allow colleagues to communicate with one another. 

External email accounts connect to other people using the Internet via telephone 
lines. An external email account is set up with an Internet Service Provider (ISP). 
Access to the ISP is gained by connecting using a modem through the telephone line 
(or a dedicated cable line). Most email connections at home are set up with this type of 
email account. 

In most businesses Outlook is set up for both internal and external email. The internal 
email is used to communicate with work colleagues, while the external email is used to 
communicate with customers and suppliers. Both of these email account types work 
through the LAN which can be configured to provide access to the ISP for specific 
computers. 

Outlook Profiles 

Setting up Outlook for use on the appropriate mail servers can be a tedious and 
sometimes frustrating exercise. 

Once the setup has been done and the connections have been established, Outlook 
stores the settings, together with other relevant information, in a user profile. If you 

have upgraded to Outlook 2010, the settings from the previous profile will be carried 
forward into the new version. 

If you are using Outlook for the first time, you will be asked for information such as 
your account user name, password and the names of the various mail servers. Your 
system administrator at work or your ISP when connecting at home will be able to 
provide this information to you. 

Once this information has been provided, it is saved in your Outlook profile and should 

not need to be changed or entered again unless some change is made to the operation 
of your computer. 

Note: It is assumed for the remainder of this booklet that you have at least one valid, 
and working, email account in Outlook 2010. 
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HOW OUTLOOK MAIL WORKS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Outlook Mail provides you with the facility 

for sending email to other computer users. 
These people can be directly connected to 
your computer via a local area network, or 

they can be many miles away, accessed 

either through special communications 
software or the Internet. In Outlook Mail, 

your email is handled just like the normal 
mail system. 

Trays and Folders 

Imagine sitting at your desk with two plastic trays in front of you, one labelled Out and the 
other labelled In. As you write a message you address it and place it in the Out box. 
Periodically someone comes along, picks up the contents of the Out box and takes them to the 
post office which then distributes the messages to the appropriate recipients. That same person 

who picks up your mail also places messages sent to you in your In box. You can then open 
these messages and read them or dispose of them into the bin. 

Outlook works in the same way, except that the plastic trays are known as folders – in fact 
there are several more folders than just In and Out. 

In Outlook you compose a message and when it is saved it is placed into the Outbox. 
Periodically, Outlook clears the contents of the Outbox and sends it to the mail server for 

delivery to the appropriate recipient. Just so that you have a record of what Outlook has sent, a 
copy of the message, together with details about when it was sent, is placed into the Sent 
Items folder. 

If you are working on a message but you haven’t finished it, you can save it as a draft in the 
Drafts folder. You can send it later when you finish it. 

When someone sends you a message it is downloaded from the mail server and placed into 
your Inbox. Here you can read it and when finished you may delete it – in which case, it then 
goes into the Deleted Items folder. 

Unlike postal mail you have several other options available to you with incoming mail. Outlook 
allows you to set up rules for handling incoming mail. For example, you can create a rule that 
tells Outlook to automatically place incoming messages from a specific sender into a special 
folder. 

Outlook also includes a junk email filter that evaluates incoming messages and sends those 
considered to be spam to the Junk E-mail folder, where the messages can be deleted without 

reading. 

Outlook Mail Folders 

Folder Mail 
Direction 

Function 

Inbox Incoming Stores messages that have been sent by other users to your 
account. 

Junk  
E-mail 

Incoming Captures unsolicited and nuisance emails sent to you – the rules 
and instructions need to be set up for this before it becomes 
operational. 

Drafts Outgoing Stores messages that you have composed without sending. 
Messages can be reviewed and sent, or saved as a draft again if 
required. Once sent the message is moved to the Sent Items 
folder. 

Outbox Outgoing Stores messages that you have composed for other users but 
which have not yet been sent by Outlook Mail to the recipient. 

Sent 
Items 

Outgoing Stores messages that you have sent to other users. 

Deleted 
Items 

Both Stores messages that have been deleted from the other folders. 
Messages here can be restored to other folders or deleted 
permanently. 
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COMPOSING AN EMAIL MESSAGE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Most of us learnt how to write letters at 
school. Email provides us with some new 
challenges that will need to be learnt. 
Email, like postal mail, has a recipient, 

needs to be addressed and can be signed 

just like a normal letter. However, while 
there are similarities between email and 
postal mail, there are also some key 
differences and jargon to become acquainted 

with. 

When you tell Outlook that you wish to create a new email message, a window will 
appear with boxes for the information and details that need to be included in the 
message.  

If you are sending internal email the recipients in the To and Cc boxes will need to be members of 
the internal email server that you are logged onto. It is most likely that these people will have 
addresses that clearly indicate who they are: e.g. Jane Doe, Bill Kline, Fred Bloggs, Mary Tink, etc. 

If you are sending Internet email then you will need to use the email addresses of the recipients. 
Email addresses are different to internal email server addresses. They appear with the name of the 

user and the domain that accesses the server for that user. Typical examples would appear like 
bwhite@bigpond.com.uk or fbloggs@here.co.uk. The addresses may also be for departments or 
areas of a business rather than an individual like sales@cars.com or service@dickson.com . The 
@ sign is pronounced at when speaking these addresses. For example, bwhite@bigpond.com.uk 
would be read as bwhite at bigpond dot com dot uk. 

To send a message you will therefore need to: 

1. create some text – this may seem obvious but you can (and sometimes might) send 
messages without text 

2. nominate one or more recipients 

3. provide a subject so that the recipient can quickly work out the gist of your message 

4. specify the level of importance for the message if required 

5. add further attachments to the message if required. 

Most of these, with the exception of nominating one or more recipients, are optional. For example, 
you don't have to include a subject – it's just that this is the right thing to do. Similarly, if you don't 
specify that this is a message of high importance Outlook will give it an ordinary importance status. 

There are also a couple of other subtleties. Unlike normal postal messages, you don't need to worry 
about putting dates on an email message because the computer does this for you. The date and time 
when a message arrives in the Inbox will be generated by the computer. When you send a message 
the computer records the date and time when it was sent. 

The computer also automatically signals to the recipient that you are the sender. However, it is still 
considered courteous to sign off an email just the same as if you were sending a postal message. 

The email address 

of one or more 
recipients 

The email address 
of people who will 
receive a copy of 
the message 

A brief title 
indicating the 
subject of the 
message 

The body (text) of 

the message 
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THE MESSAGE WINDOW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 

When you are working within a message, 
you can use the ribbon at the top of the 
message to manage the contents and 
formatting of your message. You can also 

use the navigation tools on the Quick 

Access toolbar to move through messages 
and to perform tasks such as Save and 
Undo. The Backstage (File tab) can also be 
used to further manage your email 

messages. 

2 

1 The Quick Access toolbar (QAT) appears at the top of the mail message 

window. It contains frequently-used commands so that you can quickly access 

them at any time. For example, the QAT contains a button to save, undo, redo, 

find the next item, and find the previous item. Using the Customise Quick 

Access Toolbar icon  at the end of the QAT, you can easily modify the Quick 

Access toolbar to add or remove commands of your choice. 

2 The File tab can be used to open the Backstage where you can print a message 

and set additional properties for the message. 

3 The ribbon contains five tabs (in addition to the File tab) that can be used to 
manage, control and format a mail message.  

The Message tab (as shown in the example above) can be used to apply basic 
formatting to the message, insert items, set follow-ups, and flag the importance 
of a message.  

The Insert tab contains tools that enable you to insert items such as 
attachments, tables, illustrations, text boxes, WordArt, equations, symbols and 
lines. 

The Options tab contains tools that can be used to manage your message, such 
as whether you want to use voting buttons and tracking features, specify delayed 
delivery details, set permissions and so on. 

The Format Text tab contains all of the formatting commands for your mail 

message, whereas the Message tab only contains basic formatting command 

tools. 

The Review tab contains tools that let you check a message before sending it, 

such as the spell checker, thesaurus and word count. 

4 The message header is where you address your mail message and enter the 

subject. It can also display information about the message in an Info Bar, such 

as whether or not it has been sent, if there are any actions that have been 

specified by the author, and so on. If you have more than one email account 

(Outlook 2010 supports multiple Exchange accounts within an Outlook profile), 

Outlook will display an additional field in the header called From in which you can 

select the desired email address. 

 

3 

4 
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CREATING A NEW MESSAGE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To create a new message: 
1. Click on New E-mail in the New 

group 
2. Click on [To], select the name and 

then click on [OK] 

3. Type the Subject 
4. Type the message 

Handy to Know… 

 You can create a new mail message from 
any Outlook feature by clicking on New 
Items in the New group on the Home 
tab and selecting E-mail Message. 

 If you click in To and begin typing the 
recipient’s email address, Outlook will use 
AutoComplete to display relevant 
addresses. 

2 

6 

Mail messages in Outlook can be created 
from virtually anywhere in Outlook – you 
don’t specifically need to be in the Mail 
feature. A mail message appears in a 

Message window. In this window you 

specify the recipient details, the subject and 
the main text of the message. You can also 
specify who will receive a courtesy copy (Cc) 
if desired. 

Try This Yourself: 

Before starting this exercise ensure 
Outlook has started… 

1 Click on the Home tab and 
click on New E-mail in the 
New group to display a new 
message window 

This may sound a little corny, 
but we'll actually address the 
message to ourselves… 

2 Click on [To] to open the 
Select Names dialog box 

3 Double-click on the desired 
user name to copy it to the 
message recipient box to the 
right of To 

4 Click on [OK] to place the 

name in the field to the right 
of To in the message window 

5 Click in Subject and type My 
First Email Message 

If you don’t type a Subject 
and click on [Send], Outlook 

will display a message asking 
you to confirm that you 
meant to leave the Subject 
blank… 

6 Click in the large white 
message box beneath the 
header and type: 

Today I am learning how 
to send email messages. I 
am sending it to myself. 
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CHECKING THE SPELLING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To check the spelling in a message: 
1. Click on Spelling & Grammar  in 

the Proofing group on the Review 
tab 

Handy to Know… 

 Because email messages are often 
written and sent off quickly, they tend 
to lack the formality and protocol of a 
postal message. Nevertheless, you 
should ensure the spelling is correct 

before sending the message. 

Outlook comes complete with a spell 
checker that works in the same way as in 
other applications, offering suggestions 
where appropriate. The spell checker will 

not only check the text that you type in a 

message, it will also check the Subject text 
as well. Additionally, you can use the spell 
checker to check your tasks, meeting 
requests, appointments and more. 

1 

3 

4 

5 

Try This Yourself: 

Continue using the previous 
message with this exercise... 

1 Click on the Review tab, 
then click on Spelling & 
Grammar  in the 
Proofing group to start 
the spell checker – if 
there are no errors 
Outlook will advise you 
that the spell check is 
complete 

2 Click on [OK] to close 
the message box 

3 Click at the end of the 
message text, press  

and type missages – an 
obvious spelling error 

4 Repeat step 1 to re-run 
the spell checker 

This time the error will be 
found and alternatives 
will be suggested in the 
Spelling and Grammar 

dialog box... 

5 Click on messages 
under Suggestions, 
then click on [Change] 
to make the change 

6 Click on [OK] to close 

the message box 
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ADDING AN ATTACHMENT TO A MESSAGE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Continue using the 
previous message with this 
exercise... 

1 Double-click on 
messages and press 

 to delete the 

word, then press  

twice and type 
Here's a picture of 

my favourite place. 

2 Click on the 
Message tab, then 
click on Attach File 

 in the Include 
group to open the 
Insert File dialog 

box 

3 Navigate to the 
Course Files for 
Outlook 2010 
folder, then click on 
Uluru.jpg and click 
on [Insert] to insert 

the picture file as an 
attachment 

Notice that an 
Attached field has 
been added to the 
bottom of the 
message header. It 

includes the 
Uluru.jpg file that 
you just inserted 

 

For Your Reference… 

To add an attachment to a message: 
2. Click on Attach File  in the 

Include group on the Message tab 
3. Navigate to the desired folder 
4. Click on the file  

5. Click on [Insert] 

Handy to Know… 

 Attachments are the cause of many 
computer problems, especially over the 
internet. Many computer viruses are 
transmitted over the internet through 

attachment files. 

2 

3 

Attachments are usually computer files 
that contain additional information for the 
recipient. It might be a picture file 
(perhaps you are sending a picture of a 

family wedding to an overseas relative), a 

document from a word processing 
application, or a data file from a spreadsheet 
or database. Attachments are inserted into 
the message. 
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ADDING IMPORTANCE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Continue using the 
previous message with this 
exercise... 

1 Click on High 
Importance  in 
the Tags group 

The tool will appear 
highlighted in 
orange... 

2 Click on the dialog 
box launcher  for 
Tags to open the 
Properties dialog 
box 

There are quite a few 
settings here that 

determine how and 
when your messages 
will be sent… 

3 Click on the drop 
arrow  for 
Sensitivity and 
select Private 

4 Click on [Close] to 
close the Properties 
dialog box 

Setting the 
Sensitivity to Private 
will display ‘Please 
treat this as Private’ 

in the message 
header when the 
recipient opens this 
message 

 

For Your Reference… 

To change the importance of a message: 

1. Click on High Importance  in the 
Tags group on the Message tab 

2. Click on the dialog box launcher  
for Tags 

3. Set Sensitivity as desired and click on 

[Close] 

Handy to Know… 

 Sensitivity options in the Properties 
dialog box are only advisory – they do 
not force what action the recipient 
takes. 

 Don’t overuse the High Importance 

flag. Too much use of this and your 
recipients will begin to ignore your 

messages! 

1 

2 

Outlook allows you to add importance to 
an email message. All messages have 
some degree of importance attached to 
them – unless you specify otherwise, it is 

set to normal. But, if you feel that your 

message needs more attention, you can 
assign high importance to it. By setting the 
level of importance, you also enable the 
email recipients to sort messages by 

importance. 
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REQUESTING MESSAGE RECEIPTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Continue using the 
previous message with 
this exercise… 

1 Click on the 
Options tab on the 
ribbon 

2 Click on Request a 
Delivery Receipt 
in the Tracking 

group until it 
appears ticked 

This ensures that a 
receipt will be sent 
to you when the 
message is 
received by the 

recipient... 

3 Click on Request a 
Read Receipt in 
the Tracking 
group until it 
appears ticked  

This ensures that a 

receipt will be sent 
to you when the 
message is read by 
the recipient 

 

For Your Reference… 

To request a message receipt: 
1. Tick Request a Delivery Receipt in 

the Tracking group on the Options 
tab to request a delivery receipt, or 

 Tick Request a Read Receipt in the 

Tracking group on the Options tab to 
request a read receipt 

Handy to Know… 

 While read and delivery receipts are 
useful they do not guarantee that the 
person to whom the message was sent 
was the person who actually opened it 
and read it. Sometimes, formally 

requesting a reply from the recipient is 
a better option. 

1 

2 

Just because an email message is sent to 
someone, it doesn’t necessarily mean that 
they have received or read it. If you want 
to be sure that a message has arrived and 

that it has been opened, you can mark your 
message so that an electronic receipt is 
generated and sent back to you when your 
message arrives at the recipient’s address. 

3 
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SENDING THE MESSAGE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Continue using the previous 
message with this exercise… 

1 Click on Send  in 
the message header to 
send the message 

The message will be 
placed briefly in the 
Outbox and sent at the 
next possible time 

depending on what 
other messages are 
sitting in the queue... 

2 Click on Sent Items 
in the Navigation 
pane to see the mail 
that has been sent 

3 Click on Inbox in the 
Navigation pane to 
see the incoming mail 

Since you addressed 
this message to 
yourself it may have 
arrived already! You 

may have also 
received a delivery 
receipt, similar to the 
one shown above the 
message in our sample 

 

For Your Reference… 

To send a message: 
1. Click on Send  in the message 

header  

Handy to Know… 

 Once a mail message has been sent, it 
is placed in the Sent Items folder. 
From this folder you can resend the 
message which can be handy if you 
forgot to add an attachment to the 

message, or you can send it to another 
recipient altogether. 

2 

3 

Once you have addressed the message, 
composed it, added any attachments, and 
assigned importance and receipts if 
necessary, you are finally ready to send 

the message. When you send a message it 

actually travels through two folders: the 
Outbox where it awaits transmission and 
the Sent Items box where it is saved after 
it has been transmitted. 
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CREATING AN AUTOSIGNATURE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To create an autosignature: 

1. Create a new email message 

2. Click on Signature  in the Include 
group on the Messages tab and select 
Signatures 

3. Click on [New] and name your signature 

4. Type and format your signature text in 

Edit signature, and then click on [OK] 

Handy to Know… 

 Formatting options can be applied to an 
AutoSignature if you use plain text as 
your message format. The formatting 
will not be visible in your outgoing 
messages, but it will be visible to 

recipients who use HTML or .rtf 
message formats. 

1 

2 

Even though the computer will 
automatically add your email user name to 
the email message, it is still deemed to be 
good practice to sign off on your email 

messages. These sign-offs are like the 

ones that you would use in a postal letter. 
You can be formal or informal. Some people 
also use this as a marketing or advertising 
opportunity and provide additional text or 

graphics. 

4 

Try This Yourself: 

Before starting this exercise create a 
new blank message... 

1 Click on Signature  in the 
Include group on the 
Message tab, then select 
Signatures to open the 
Signatures and Stationery 
dialog box 

2 Click on [New] to open the 

New Signature dialog box 

3 Type Personal Signature, 
then click on [OK] 

4 Click in the text box for Edit 
signature and type Yours 
sincerely, press  twice, 

type your name, press  

twice again and type your 
company’s name  

You can use the formatting 
tools to enhance your 
signature – for example, we 
formatted ours as Lucida 
Handwriting, 18 pt, bold... 

5 Click on [OK] to save your 
signature and return to the 
email message, then press  

to close the untitled message 

Personal Signature will be 
added to the list in Signature 
on the Message tab 
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USING AN AUTOSIGNATURE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Before starting this 
exercise ensure you have 
created an 
AutoSignature... 

1 Create a new email 
message 

Notice how the 
AutoSignature has 
appeared in the white 

message box… 

2 Select your user 
name in To, type 
Testing the 
AutoSignature in 
Subject and type In 
this message I am 

testing the 
AutoSignature. It 
is working fine. 
above the 
AutoSignature as 
shown 

3 Click on Send  to 

send the message 

 

For Your Reference… 

To use an AutoSignature: 
1. Create a new email message – the 

AutoSignature will appear 
automatically 

Handy to Know… 

 Although you can create more than one 
AutoSignature, only one AutoSignature 
will be set as the default. If you want 
to insert a different AutoSignature, 
click on Signature  on the 

Message tab and select the signature 
name from the list of signatures. 

1 

2 

AutoSignatures are applied automatically 
to all new email messages that you create. 
Once you have created an AutoSignature 
and nominated it for new mail messages,  

it will appear at the bottom of any new email 
messages that you create. This is a great 
time saver if you create many emails a day. 
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REMOVING AN AUTOSIGNATURE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To remove an AutoSignature: 
1. Create a new email message  
2. Click on Signature  and select 

Signatures 
3. Select the signature and click on 

[Delete] 
4. Click on [OK] 

Handy to Know… 

 You can also access the Signatures 
and Stationery dialog box by clicking 
on Signature  in the Include group 
on the Insert tab. 

2 

6 

Outlook allows you to have multiple 
AutoSignatures. For example, you may 
create one for formal business emails, 
another for personal emails, and perhaps 

several different ones for the various roles 

or jobs that you perform in your 
organisation. To ensure that the list of 
available AutoSignatures doesn’t get out of 
hand, you can remove unwanted signatures. 

Try This Yourself: 

Before starting this exercise 
ensure you have created an 
AutoSignature... 

1 Create a new email 
message 

2 Click on Signature  
and select Signatures 
to open the 
Signatures and 

Stationery dialog box 

3 Ensure that Personal 
Signature is selected 
under Select 
signature to edit, 
then click on [Delete] 

You will be asked to 

confirm your 
intention... 

4 Click on [Yes] to 
confirm the deletion 

5 Click on [OK] to close 
the Signatures and 
Stationery dialog box 
and then press  to 

close the email 
message 

6 Create a new mail 
message  

Notice that the 
AutoSignature has not 
been inserted into the 
message... 

7 Press  to close the 

email message 
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SENDING A COURTESY COPY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Before starting this exercise 
ensure Outlook has started... 

1 Create a new message, 
then type This 
message has a copy 
in Subject and type In 
this exercise I’m 
creating a message 
with a courtesy copy 
to see how it works. 
in the message box, as 
shown 

2 Click on [To] to open 
the Select Names 
dialog box 

3 Click on your user name 

and then click on [To] 

4 Click on the same name 
again and then click on 
[Cc] 

5 Click on [OK] to return 
to the message 

The same name will 

appear in both To and 
Cc... 

6 Click on Send  to 
send the message 

After a few moments 
the message will appear 
in your Inbox. If you 
click on it you will see 
that your name appears 
in both To and Cc 

 

For Your Reference… 

To send a courtesy copy: 
1. Create a new message, then click on 

[To] 
2. Select the recipient and click on [To] 
3. Select the recipient for the courtesy 

copy and click on [Cc] 
4. Click on [OK] and then click on Send 

 

Handy to Know… 

 When creating a new mail message, 
you can open the Select Names dialog 
box by clicking on either [To] or [Cc] 
in the new message window. 

1 

4 

With normal postal letters, it can be time 
consuming to send additional copies of a 
letter to someone else. You need to 
photocopy the letter, create a new 

envelope and spend just as much time and 

effort as you did on the original. But with 
email, you can send a copy of a message to 
another person simply by inserting their 
email address in the Cc (Courtesy Copy) 

field. 
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SENDING A BLIND COPY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To send a blind copy of an email: 
1. Create a new message 
2. Click on Bcc  in the Show Fields 

group on the Options tab 

3. Type the blind copy recipient in Bcc 

Handy to Know… 

 You can add a blind copy recipient by 
clicking on [To] or [Cc] in the header 
area of a message. You can then add 
recipient names to Bcc in the Select 
Names dialog box. When you close 

this dialog box, the Bcc field will 
appear in the header of the email. 

1 

3 

When a recipient receives an email that 
has also been sent to others as a courtesy 
copy, the main recipient can see exactly 
who has received a copy of the email in 

the Cc field. But if you wish to send a copy 

of an email to another person without the 
main recipient being aware of this fact, you 
can send the message as a blind copy. The 
Bcc field will not appear in the main 

message. 

Try This Yourself: 

Before starting this exercise 
ensure Outlook has started... 

1 Create a new message, 
then type This 
message has a blind 
copy in Subject and 
type In this exercise 
I’m creating a 
message with a blind 
copy to see how it 
works. in the message 
box, as shown 

2 Click on [To], double-
click on your user name, 
and then click on [OK] 

3 Open the Options tab, 

and then click on Bcc  
in the Show Fields 
group 

The Blind Copy (Bcc) 
field will appear in the 
message header... 

4 Click on [Bcc], double-

click on your user name, 
and then click on [OK]  

You will receive a blind 
copy of the email... 

5 Click on Send  to 
send the message 

You must turn off Bcc… 

6 Create a new message, 
repeat step 3 to 
deselect Bcc, then press 

 to close the message 
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CONCLUDING REMARKS 
 

 

 

 

Congratulations!  

You have now completed the Sending email booklet.  This booklet was designed to get 
you to the point where you can competently perform a variety of operations as listed in the 
objectives on page 2.  

We have tried to build up your skills and knowledge by having you work through specific 

tasks. The step by step approach will serve as a reference for you when you need to repeat 
a task. 

 

Where To From Here… 

The following is a little advice about what to do next: 

 Spend some time playing with what you have learnt. You should reinforce the skills 

that you have acquired and use some of the application's commands. This will test 
just how much of the concepts and features have stuck! Don't try a big task just yet if 
you can avoid it - small is a good way to start. 

 Some aspects of the course may now be a little vague. Go over some of the points 
that you may be unclear about. Use the examples and exercises in these notes and 
have another go - these step-by-step notes were designed to help you in the 
classroom and in the work place! 

Here are a few techniques and strategies that we've found handy for learning more about 
technology: 

 visit CLD’s e-learning zone on the Intranet  

 read computer magazines - there are often useful articles about specific techniques 

 if you have the skills and facilities, browse the Internet, specifically the technical 
pages of the application that you have just learnt 

 take an interest in what your work colleagues have done and how they did it - we 
don't suggest that you plagiarise but you can certainly learn from the techniques of 
others 

 if your software came with a manual (which is rare nowadays) spend a bit of time 
each day reading a few pages. Then try the techniques out straight away - over a 
period of time you'll learn a lot this way 

 and of course, there are also more courses and booklets for you to work through 

 finally, don’t forget to contact CLD’s IT Training Helpdesk on 01243-752100 
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